Jlexuusn 14. IIpouexyps! B si3bike Delphi (mpoxokenue)
14.1 lIpouenypsi Vs @ynkunu. [Ipumep

[lepenenaem, yxe HamMCaHHYIO NpOrpaMMmy C IMpoleaypamMu OOLIEro BHlA, B
nporpamMmy ¢ (PyHKITUSIMHU.

Ycnosue 3aJa4um.

Jlana xBanpatHas Matpuia A pazmepom NXN.

Ecim konmmaectBo (KOI) cTpok, B KOTOPBIX HAXOIATCS TOJBKO MOJIOKUATEIBHBIE 3JIEMEHTHI,
oounbire N/2,

Haiitu SA — cpenree apudMeTrnaeckoe 3HAUCHUH BCEX MOJIOKUTEIBHBIX JJIEMEHTOB,

WHA4e

Haiitu Max — makcuMmallbHOE 3HAUYE€HHE CpEeIU DJIEMEHTOB, JICKAIIUX BBIIIEC TJIaBHOU
JAArOHAJIM MaTPULIbI U HA HEU.

R

B/B N, {Atizin, j=1n
: AO

Hantun kon-Bo cTpok - Kol AO0.1

A0.1 A0.2 A0.3

@ A0.1.1 | - NpoBepka CTPOKK

A 4

Hantun cpen.apndpm. - SA A0.2
¥
Bbie SA
Hantn makcumym - Max AO.3
v
BbiB Max
. v

Bce uerbipe BblIeneHHbIE MOA3aJauM, cleiaeM (YHKLIHUSIMH, MOCKOJIbKY BO BCEX
YEeThIpEX €CTh YKCTO BBIXOAHOW mMapaMerp mnpoctoro Tuma. Jns sTtoro BHeceM 5
VM3MEHECHHUU B KKIYIO U3 IIPOLIEAYP U U3MEHUM MX BbI30BbI. Kakue 310 5 n3meHeHuii:

1) xmodyeBoe cioBo procedure mensiem nHa function; 2) youpaem wu3 crmcka
napaMeTpoB BBIOpaHHBIM JUIsi BO3BpaTa B KadeCTBE pe3ysbTaTa YUCTO BBIXOJHOM
napameTp (momyctum, X), 2) nodamasis ero (X) omucaHWe B CHHCOK JIOKAJIbHBIX
IIEpPEeMEHHBIX, 3) a ero (X) T yKa3blBaeM KakK THI pe3yJabTaTa QyHKIUH; 5) IMOCIIe BCeX
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ormepaTopoB Tena ObIBIIEH mpoueaypsl g00aBisieM emie OAWH: MMeHH (YyHKIHHU
npucBauBaem Bc€ TOT ke X.

Hampuwmep, ectp mpoueaypa, y KOTOpPOH €CTh YHUCTO BBIXOIHOW mapamerp K
IIPOCTOTO TUNA!

Procedure Proc( const a: real; b: byte;
var r: real; out k: integer);

Var d: double;
Begin
<Teno npoueaypbi>

End;

BbI30B:
Proc( a,b,c,k);

BHocuMBbIC M13BMEHEHUS:

"Ipouenypa n GyHKUMS

Function |Proc( const a: real; b: byte;
var r: real=saoR=miegey) . Integer;
Var d: double; |Kk: integer;
Begin
<Teno npouenypbl>
Proc:=k; wnn Result:=k;
End,;

BbI30B:
Proceas5,K); k := Proc( a,b,c);

Ecou Obl y mpouenypsl He ObUIO YHUCTO BBIXOJHOTO IapaMeTpa, HO ObLT Obl
napameTp-rnepeMeHHas P MpoCcTOro TUIa, TO MOXKHO OblIO ObI CHauasa pas3/eauTh ero Ha
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JBa TMapaMeTpa: YUCTO BXOMHOW Pl, mns mepegaum HAYaIbHOTO 3HAYECHHS W YHUCTO
BBIXOJTHOM P2, a 3aTeM mpeoOpa3oBaTh MPOIEAYPY B (PYHKITHIO IO BBIMIC MTPUBEICHHOMY
CIICHApHIO.

Ecnu Ob1 y mpoueaypsl BooOIne He ObLIO KaHAMAaTa Ha pPe3yibTaT, TO MOKHO
BCerja ero J00aBUTh, TOCKOJBKY pe3yiabTaToM (YHKIMH YacTO BBICTYMAeT OICHKA
yCIEMHOCTH €€ BhINOJAHCHHS: True (wau 0) mpu ymadyHoM BbeinmoiHeHuu, False (wnmm
HEHYJICBOW KOJ OIIMOKH), €CJIM BBIMOJHUTH MO KAKOH-TMOO MPUYMHE HE BO3MOXKHO,
HanpuMep, HEBO3MOXEH BBOJI ITPH OTCYTCTBUHU HY)KHOTO (aiiyia Ha JUCKE WU OTCYTCTBHSI
COOTBETCTBYIOIIUX TPaB JIOCTyIa K HEMy, CIydau TIEPETOHECHUS WK JICTICHHs] Ha HOJb
IIPU BBIYUCIICHUU IO CIOXHBIM MareMaTtudeckuMm ¢dopmynaMm. To ecTe B mpocTeiiem

ClIy4ae U3 MpoLeIypBblL:

Procedure F (<cnmcok QOpMAaJIbHBEIX I1apaMeTpOB>) ;
Begin

<TeJIO NpOoLenypPB>
End;

MOJXHO CIOCJIaThb q)YHKI_[I/IIOI

Function F (<cnmcox ¢opMaJsIbHEX NapaMeTpoB>): Boolean;
Begin
F := True;
Try
<TeJIO NPpoLeypE>
Except
F := False
End;
End;

Ha npumepe 4derbipex (QyHKUUH sl pELICHUs BBIIIE NMPUBEICHHON 3a1ayul W3
MPEIBIAYIIEH JEKIUHN:

[Ipouenypa mnoucka cpeaHero apu(pMeTUYEeCKOro MOJOXKHUTEIbHBIX 3JIEMEHTOB
(KOTOpBIE TapaHTUPOBAHHO TaM MPUCYTCTBYIOT):

Const Nmax = 10;
Type Matr = array [l..Nmax, 1..Nmax] of real;

Procedure FindSA( N: byte; var A: Matr; out SA: real);
Var i,Jj,K: byte; S: real;
Begin
S:=0; K:=0;
for i:=1 to N do
for j:=1 to N do
if A[i,3]]1>0 then
begin
S:=S+A[i,]]; K:=K+1;
end;
SA:=S/K;
End;




DOyHKUUS:

Function FindSA( N: byte; var A: Matr): real;
Var i,j,K: byte; S: real; // SA: real;
Begin

S:=0; K:=0;

for i:=1 to N do
for j:=1 to N do
if A[i,3]1>0 then

begin
S:=S+A[1i,73]; K:=K+1;
end;
FindSA:= S/K; // BMecTO: SA:=S/K; FindSA:=SA;

End;

Hpouez[ypa ITOMCKa MAKCUMYMa BBIIIC U HA caMoM rJ1aBHOM JuaroHaliu:

Procedure FindMax( N: byte; var A: Matr; out Max: real);
Var i,7: byte;
Begin

Max:=A[1,N];

for i:=1 to N do

for j:=1 to N do
if Ali,j]l>Max then
Max:=A[1i,7];

End;
DyHKIUS:
Function FindMax( N: byte; var A: Matr): real;
Var i,7: byte; Max: real;
Begin

Max:=A[1,N];
for i:=1 to N do
for j:=1 to N do
if Ali,j]l>Max then
Max:=A[1i,7];
FindMax := Max;
End;

I[Iporierypa mpoBepku i-oi CTpOKH (BCE JIM MOJIOKUTEIBHBI):

Procedure Check i (const N,1i: byte; var A: Matr; out Flag: boolean) ;

Var J: byte;

Begin
Flag:=TRUE; J:=1;
while (Jj<=N) AND Flag do
begin

if NOT (A[i,]]1>0) then
Flag:= FALSE;
inc(3);
end;
End;




DOyHKUUS:
Function Check i( const N,i: byte; var A: Matr): boolean;
Var J: byte; Flag: boolean;
Begin
Flag:=TRUE; j:=1;
while (Jj<=N) AND Flag do
begin

if NOT (A[i,3j]1>0) then
Flag:= FALSE;
inc(3);
end;
Check i := Flag;
End;

[Iponeaypa nojacuera KOJIUYECTBA CTPOK € TOJIBKO MOJIOKUTEIIBHBIMH 3JIEMEHTAMH,
BBI3BIBAIOIIAS MIPOIIEAYPY MPOBEPKH I-0f CTPOKH:

A0.1 — HanTtn Konn4yecteBo CTPOK

Procedure FindKol( const N: byte; var A: Matr;
out Kol: byte);
Var i: byte; Flag: boolean;

Begin
KOI:.:O; BX |NPOM | BbIX
For _|.—1 to N do Kol | - s + lout
begin
Check_i(N, i, A, Flag); F'ag o - |NoK
If Flag then | - + - |JoK
inc(Kol); N + ] - |const
end; A |+ - - |const/
=nd var

@DyHKIMS, BbI3bIBAIOIIAsA (PYHKIIUIO TPOBEPKU CTPOKHU:




AO.1 — HanTtn KonnyecTBoO CTPOK

Function FindKol( const N:
Var

Begin
Kol:=0;
Fori:=1to N do
begin
Flag := Check_i( N,i,A);
If Flag then
iInc(Kol);
end;
FindKol := Kol;
End;

byte; var A: Matr): byte;

I, Kol : byte; Flag: boolean;

BX | MPOM | BbIX

Kol | - + + | nok/
Result

Flag| - - |NoK

i - + - | NOK

N + - - |const

A + - - | const/
var

Br3piBaromias mporpaMmma ¢ npoieaypamMu oo1ero Buia.

0 e

B/B N, {Aij}izl,N, i=1.N

v

Hantn kon-Bo cTpok - Kol

A 4

HanTtu cpen.apudpm. - SA

v
BbiB SA

Hantn makcumym - Max

v
BbiB Max

Var

N: Byte;

A: Matr;

Kol: byte;

SA, Max: real;

Begin

VvodVyvodNA( N, A);
FindKol( N, A, Kol);
if Kol > N/2 then
begin
FIndSA(N, A, SA);
writeln(‘Kol> N/2 and Sa=*, SA:7:3);
end
else
begin
FindMax( N, A, Max);
writeln(‘Kol<=N/2 and Max=‘,Max:5:1);
end;

writeln(‘Press ENTER’); readin;

End.




Bri3biBaromast mporpamma ¢ QyHKIMSIMH:

MOHO COKpaTUTh MPOTPAMMHBIN KOJ,
HO HE OJIOK-CXEMY:

Var
N: Byte;
A: Matr;
Kol: byte;
SA, Max: real;

Begin
VvodVyvodNA ( N, A);

Kol := FindKol( N, A);
if Kol > N/2 then
begin
SA := FindSA( N, A);
write ('Kol> N/2 and ');
writeln('Sa="'", SA:7:3);
end
else
begin
Max := FindMax( N, A);

write ('Kol<=N/2 and ');
writeln('Max=', Max:5:1);
end;

writeln ('Press ENTER');
readln;
End.

Var
N: Byte;
A: Matr;
Begin

VvodVyvodNA ( N, A);

if FindKol( N, A) > N/2 then
begin

write ('Kol> N/2 and Sa="');
writeln (FindSA(N, A):7:3);
end
else
begin

write ('Kol<=N/2 and Max=");
writeln (FindMax (N, A):5:1);
end;

writeln ('Press ENTER');
readln;
End.




14.2. BHyTpeHHHe U BHellIHME ONMCaHus npoueayp. Moayau

JIJIS  WCTIOJIB30BaHMS BHYTPEHHUX NPOIEAYP HX OIMCAaHUS Pa3MEIIaloTCs B
COOTBETCTBYIOIIMX pa3jeliax TJIaBHOW MporpamMmsel (program), onvcanusi Opoueayp — B
paszerne mpoIieayp, a BI30B MPOIEAYp — B pa3zelie OnepaTopoB MPOrpaMMbl I IPYTOn
IPOIEAYPHI TOTO KE MOTYJIS.

Omnucanvsi BHEIIHUX MPOLEAYP pa3MeIIaloTcs B OTAEJBHBIX (paiiiiax — MOIYJIsIX,
UX ele Ha3bIBAIOT OWOJMOTEKaAMHU TOANporpaMM. MOIyIH TPEACTABIAIOT COOOH
OTJICTbHBIE CIMHUIIBI HCXOHOTO TEKCTa, M MOTYT OBITh pa3HBIX BHJIOB:

1) cratndeckue MOAYIH (KJIFOYEBOE CJIOBO — UNIt, HCXOHBIN KO pacrojiaractcs B
daiine ¢ pacmmpenneM Pas (mepBbie Tpu OyKBBI Ha3BaHMs s3bika Pascal, mpapomurens
Delphi), mocire mpomexyrounoit kommwissiuu cranoButcs *.dcu (Delphi Compiled Unit),
a 3aTeM BKJIIOYACTCS B COCTaB oO0Iiero ¢ raBHou mporpammoit (*.dpr — Delphi Project)
UCHIOJTHSAEMOT0 (haiiia ¢ pacIIMpEeHUEM EXE),

PRJ/ DPR

EXE

PAS ——| DCU

2) nmuHaMHYecKu mojkitodaembie OubOamoTexku — DLL (Dynamic-Link Library),
KOTOPBIC TOXE MOXKHO TMOJKIIFOUATh U CTATUICCKU, HO OHU HE BXOJST B COCTaB OOIIIEro ¢
nmporpaMMoii exe-¢aiisma, 4TO IMO3BOJSET YMEHBIIUThL €ro pa3Mep W MOJAMEHATH TpHU
Heooxonumoctu dll-aiin, He MeHssT caMoii MPOrpaMMBbl, B KPOME TOTO, €CJIM KaKasi-THoo
OMOIMOTEKa WCMOIB3YEeTCS HECKOJBKUMH IMPOrpaMMaMH, TO B OINEPATUBHYIO TaMSTh
3arpyskaercs Tojabko oaHa komus 3Toit DLL. B DLL M0OHO XpaHUTh OMUCaHUs MPOIEAYD
U (DYHKIMH, HO HE KOHCTAHT, THUIIOB WJIM MEPEMEHHBIX, U MOXHO HCITOJIb30BAaTh TOJBKO
0a30BBIC THIIBI, HO 3aTO MCXOJHBIA KOJI TaKOW OMOJIMOTEKHM MOJKET OBIThH HAaIlMCaH Ha
S3bIKE MPOTrPAMMHPOBAHMS, OTIMYHOM OT SI3bIKa MPOTPAMMHUPOBAHHUS, HA KOTOPOM
HalKcaHa MporpamMma, K KOTOpOW moakitodaercs otkommwiupoBaHHbiil dll-gain. B
s3pike Delphi mpu HamwvicaHWKM MCXOTHOTO KOJa MCIONb3yeTcs KirodeBoe ciaoBo library,
UCXOIHBIN KoJ pacnojiaraercs B (aiine ¢ pacmmpenuem dpr (Delphi Project), a mocie
komnwisnuu  nonydaer pacmmpenue  dll.  Tlpumep cratmyeckoro moOIKITIOYEHUS
Kernal32.dll nns uicrions3oBaHust mporeIyp W3MEHEHHsI KOJOBOW CTPaHUIIBI:

// «BHTamMM» OBe QYHKUMM M3 gapa Windows:

function SetConsoleOutputCP (wCodePagelID: cardinal): cardinal;
stdcall; external 'Kernel32.dll';
function SetConsoleCP (wCodePageID: cardinal): cardinal;

stdcall; external 'Kernel32.dll';

begin
// cMeHMM KOmoBHE cTpaHMuUbe (Windows mo ymoJuaHuo
// ON8a KUPUILJIMLE MCIOJb3yeT KOOUPOBKY 1251):
setConsoleCP(1251); // nna BBOmA
setConsoleOutputCP (1251); // nmg BHBOIA
writeln ('llo-pyccku, ecnu mpudT cMeHuTb Ha Lucida Console');
write ('Haxmure ENTER nna 3aBepmenHuda'); readln;

end.
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3) makerer *.bpl (Borland Package Library) — 510 o0c00bIM 00pa3om
orkommnunupoBanusle DLL, ontumMusupoBaHHBIE [UIsI COBMECTHOTO HCHOJIb30BaHUS
Delphi-nporpammamu, wnu  cpemoit  paspabotku mpuioxenuid Delphi, wm u
nporpamMmamMu u cpenod. B ormimume ot DLL makeTel MOryT XpaHWTh M NEpeaaBaTh
nporpaMMe THUMbI (BKJIOYas Kiaccbl) U AaHHble. OHM pa3paOoTaHbl CHELUAIBHO IS
XpaHEHUs] KOMIIOHEHTOB, Pa3HOr0 PoJia IKCIEPTOB, PEAAKTOPOB CIOKHBIX CBOMCTB U T.II.

B Monyne (3mech u nanee, U B TUIIOBOM pacyere MojpazyMeBaroTcst UNit-chaiier)
OOBIYHO pa3MeLIal0T KOHCTaHTHI, TUIIbI, IPOLUEAYPBl U (PYHKLNHU, KOTOPbIE MOTYT OBITh
UCIIOJIb30BaHbl/BbI3BaHbl M3 OCHOBHOM NpOrpaMMbl WM Apyrux moxayieil. dain ¢
UCXOJHBIM TEKCTOM MOJYJISI TOJDKEH COCTOATh KaK MUHHUMYM U3 TPEX 4acTeil:

1) 3aromoBok momymnst — UNit. Kaxkaelid MOIyb JTOJDKEH HAYMHATBHCS CO CTPOKH,
OOBSIBISIONICH, YTO JAHHBIA OJIOK TEKCTa SIBJISIETCS MOJYJIEM, W 3aJarolieid UMs 3TOTO
Moxayis. IMsa Moayiis Bcerja JOJKHO COOTBETCTBOBATh MMEHU €ro (ailia, u Hao0opoT.
Hanpumep, eciu M daiina unitl.pas, To ums moayis unitl.

2) onucanue uHTepdeiica. Bropoil pyHKIIMOHATIBHON CTPOKON B MOAYJE TOJKEH
ObiTh omepatop interface. Bce omucanms, caenaHHBIE MEXIY OSTOW CTPOKOH W
orepatopoM implementation maHHOrO MOIyJsl, JOCTYIIHBI HM3BHE M MOXKET OBITh
UCIOJB30BaHO JIPYTUMH MporpaMmMamMu M MOAyJIsMU. VIMeHHO B 3Toi yacTu
ONMCHIBAIOTCS KOHCTaHThl, THUIbL, MPOLEAYPhl U (PYHKIHMH, KOTOPBIE JOJKHBI OBITH
JOCTYIHBI OCHOBHOM INporpamme Wid ApyruM MoayisiMm. [[nst mpouenyp um ¢GyHKUIui B
3TOM pasjielie MOMEIIAI0TCS TONIBKO UX 3ar0JIOBKH!

3) pasznmen peanuzauuu. Cleayer 3a ONMCAHUEM HHTepdeiica M HauuHaAeTCs ¢
oreparopa implementation, pacronoxxeHHOro B OTHENBbHON cTpoke. B aTtom pasmene
MOMEIIAIOT MOJIHbIE OMUCAaHUA (3ar0JIOBKU + TeJa) Mpouenyp U PyHKIMi, yIOMSIHYTHIX B
pasnene interface mamHoro moxayias.  Kpome Toro, 37aech MOTYT OBITh OIHCAHBI
KOHCTAHTHI, THIIbI, TIEPEMEHHBIC, MPOIEAYpbl M (YHKIMH, KOTOpble OYyAyT JOCTYITHBI
TOJIBKO B MpeJiesax 3TOr0 MOIYJIS.

4) 3akaHYMBaCTCS MOJYJb, KAK U OCHOBHAs ITporpamma, ciioBoM End u Toukoii.

CTpykTypa THIMYHOT0 MOIYJIS:

Unit unitl; {damnn, 3HaumT, IOOJIXKEH Haz3bpBaThbcda unitl.pas }
Interface
uses <CIMCOK MCIIOJIb3YEMEIX MOIYyJIel>

{onmucanma, DocTyIlHBE M3BHEe: }
const <ommMcaHMdad KOHCTAaHT>
type <omnmcaHmMe TUIIOB>

<3aroJIOBKM NIpouenyp u oOyHKUMII>

Implementation
<[IOJIHEIE ONMCAaHMA Npouelyp M QyHKUMM,
3aTOJIOBKM KOTOPHBIX pasMeleHH B paszejie interface>
End.




10

[ToMuMO 3THUX TpeX yacTed, MOIYJb MOXKET UMETh €Il JBE HeOoOs3aTeabHbIC
YacTH.

4) pasnen wHuManm3anuu. Hadwaaercs co cioBa initialization u coxepxut
IPOTPaAMMHBIA TEKCT, HEOOXOAMMBIH JJIs1 Havajga pabOThl ¢ 3TUM MOIYJIEM. DTOT TEKCT
OyZieT BBIMIOJHEH TOJBKO OJIMH pa3 — Iepe]l HauaioM BBITIOJHEHUS OCHOBHOM MPOTPAMMBI.

5) pasmen 3aBepiienus. Hauwmnaercs ¢ ximodeBoro ciopa finalization wu
pacroyiaraeTcsi mocjie pasjeia MHUIHAIU3AuU. DTOT pas3jiei COACPKUT MPOrpaMMHbBIN
KOJI, HEOOXOUMBIH IS 3aBEPIICHUS PA0OTHI MOAYJISA. DTOT KOJ OY/IET BBIMOJHEH TOJIBKO
OJIUH pa3 — PHU 3aBEPIICHUH PAOOThI IPOrPAMMBI.

Paznensl MHUIMATN3AIUE U 3aBEPIICHUS TTOKIF0YaEMbIX MOJYJICH BBITOIHIIOTCS
B MOPSIKE, B KOTOPOM 3TH MOJYJIH OTKPBIBAIOTCSA KOMITHIATOPOM (T.€. MEPBBI MOIYJIb B
ONMHUCaHWKM USES OCHOBHOW MpOTrpaMMbl, IMEPBBIA MOAYJIb B ONHUCAaHHHM USES paszeina
interface sToro Mmomyss u T.1.).

IosHast CTPYKTypa MPOrPaMMHOTO MOJTYJIS:

Unit <uma mMonmyiiga>;

Interface
uses <CIMCOK MCIIOJIb3YEeMBIX MOIyJIel>

{onmucaHmsa, pocTyINHBEE M3BHE: }
const <omnmMcaHMS KOHCTAHT>
Ltype <omnmcaHme TUIIOB>
var <omnmMcaHue IMIepPeMEeEHHBIX>

<3aroJIOBKM NOpouenyp " OyHKLUMMI>

Implementation
uses <CHMCOK MCHOJIb3YEMEIX MOIYyJel>

{onmcaHMsa, OOCTYIHEE BHYTPM MOIYJIS: }
const <omnmcaHMdad KOHCTAHT>
Ltype <omnmcaHme TUIIOB>
var <omnmMcaHue IMIepPeMEHHBIX>

<JIOKaJIbHBEIE OJIS MOOYJIA NPOLUenyps M OGOyHKLIMUM>

<IIOJIHBIE OIMCAaHMA npouenyp M OyHKUUM,
3aT'0JIOBKM KOTOPBIX PasMelleHbl B pasmnejie interface>

Initialization
<onepaToph MHULIMAIM3ALUN>
Finalization

<omnepaTops 3aBepleHrs>
End.
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s noAKIroueHrs MOAYJIEN UCTIOJIb3YETCS pa3iesl USES, B KOTOPOM YKa3bIBAECTCS
CIIUCOK WX MMEH 4Yepe3 3amsaTyio. B Momyne MoxkeT ObITh JBa ommcaHus USES: OJHO B
paszzene interface, npyroe — B pazaene implementation.

MHoraa BO3HHKAIOT CHTYAIlMH, KOTJIa OJUH MOAYJb, HanpumMep, UNitl, ucnons3yer
JPYroi MOAyJb, HarpuMep, UNit2, KOTOPBIH B CBOIO ouepes UCToib3yeT Unitl. Hamuune
TaKuX B3aUMHBIX (HMKJIMYECKHX) CCBLIOK TOBOPUT O NPOCUYETAX, AOMYLIEHHBIX IpU
MPOCKTUPOBAHUU CTPYKTYpPbI MPUIOKEHUSA. DTy MPOOJIEMY MOXKHO PEIIUTh CO3JJaHUEM
TPETHEro MOAYJIS, KyJa CJIeIyeT OMECTUTh HEOOXOIUMBbIE i paboThl 000MX MOAYJeH
KOHCTaHTBbI, TUIIbI, IEPEMEHHBIE, TPOLIETypbl U PYHKIUU. ECiu 3ToO HEBO3ZMOXKHO, MOKHO
pa3MECTHUTh B OJJHOM MOJIyJI€ CChIIKY Ha BTOPOM MOAYJb B pasjedne interface, a Bo Bropom
MoJTyJIe — B pasaene implementation.

Ilpumep. Ooun mooyns (Unit) ¢ npouedypamu

[lpy onmcaHWd BHEMIHHUX TMPOIEIYP OMNMCAaHUS TIJIO0ANBHBIX OOBEKTOB
pa3MemarTcs B COOTBETCTBYIOIIMX pasjieiax BHYTpH paszena interface momyns (unit),
TaM JK€ Pa3MEIIAIOTCS 3aroJIOBKU MPOLEAYp, a ONUCAaHHS MPOIEeIyp — B pasielie
implementation mosmysas (unit), a BBI30BBI MPOILEAYP OCTAIOTCS B pasjieie OINepaTopoB
BBI3BIBAIOIICH TMporpaMMbl. B rimaBHOW mporpamme (program) ykasbIBaeTcsi HMs
UCIIOJIb3yEMOTO MOJTYJISl B pa3jieiie USES.

[Ipumep | Ha cnenyromieil cTpaHuUlE.

Ilpumep. Heckonvko moodynen (UNit) ¢ npouedypamu

CoznmaguMm Uit kaxaoud w3 AByx npouenyp (cMm. Ilpumep 2 Huxe) coOCTBEHHBIN
MOy b, OnucaHus TIOO0AIBHBIX KOHCTAHT W THIIOB, HEOOXOJMMBIX BCEM OCTaJbHBIM
MOJIYJISIM, 1IeJecoo0pa3HO TaKKe pa3MeCcTUTh B OTIeiabHOM Moayne (Unit) B pasaerne
interface, mpu »TOoM peanu3anvionHas yacTh Implementation ocranercs mycroi. B
porpaMMe U MOAYJISIX YKa3bIBAIOTCS MMEHA MCITOJIb3YEMBIX MOJYJICH B pasjere USES.

CBsi31 MEXITy MOJYJISIMU B CIIAYIOIIHUX JIBYX TpPUMEpax:

[Iporpamma progl IIporpamma prog2 IIporpamma prog3
A 4 / \
Mopuysns unitl Mopuyss unitProc Mopayse unitFun
npoueaypa byHKIwS
\ | /

Monyne unitTyp
KOHCTaHTHI, THIIbI




[Tpumep 1:
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IIporpamma 6e3 Mmoayast

IIporpamma
¢ NOAKJIIOYEHHBIM MOAYJIeM

MoayJb ¢ KOHCTAHTAMM,
THIIAMM, TPOLeyPAMH U

(pyHKUMAMHU.
Program progl; Program prog2; Unit unitl;
{$SAPPTYPE CONSOLE} {$SAPPTYPE CONSOLE} Interface
Uses unitl;
Const Const
nmax=20; nmax=20;
Type Type

ma = array[1..nmax] of shortint;

Procedure psum(const n: byte;
var a: ma;
out S:integer);
Var i: byte;
Begin
S:=0;
For i:=1to ndo S:=S+a[i];
End;

Function fsum(const n: byte;
var a: ma): integer;
Var i: byte; S:integer;
Begin
S:=0;
Fori:=1to ndo S:=S+a[i];
Fsum:=S
End;

Var a: ma; i: byte; sum:integer;

Begin
Write(‘n="); readln(n);
Writeln(‘A(’,n,”):’);
For i:=1to n do read(a[i]);
Readin;

Writeln(‘procedure psum’);
psum(n, a, sum);
Writeln(‘sum =, sum);

Writeln(‘function fsum’);
Sum:=fsum(n, a);
Writeln(‘sum =, sum);

Write(‘Press Enter’); readln;
End.

{Bce KOHCTaHTHI,
THITBI, IPOLIEAYPHI U PYHKIIUH

B oT/IeIbHOM Moyiie (unit)}

Var a: ma; i: byte; sum:integer;

Begin
Write(‘n="); readln(n);
Writeln(‘A(C,n,”):’);
For i:=1to n do read(a[i]);
ReadIn;

Writeln(‘procedure psum’);
psum(n, a, sum);
Writeln(‘sum =, sum);

Writeln(‘function fsum’);
Sum:=fsum(n, a);
Writeln(‘sum =, sum);

Write(‘Press Enter’); readln;
End.

ma = array[1..nmax] of shortint;

Procedure psum(const n: byte;
var a: ma;
out S:integer);
Function fsum(const n: byte;
var a: ma): integer;
Implementation

Procedure psum;
Var i: byte;
Begin
S:=0;
For i:=1to ndo S:=S+a[i];
End;

Function fsum;
Var i: byte; S:integer;
Begin
S:=0;
Fori:=1to ndo S:=S+a[i];
Fsum:=S
End;

End.

B peanr3auOHHON
JIOITyCTUMO
mapaMeTpsl npouenyp 51
byHKIMH, a  TakkKe  TUI
pe3ynbTaTa QyHKIHH.

Y4acTH
OIyCKaTh
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IIporpamma 6e3 Mmoayast

IIporpamma
¢ NOAK/JIIOYEHHBIMH MORYJISIMHU

Moay/iu ¢ KOHCTAHTAMH U
THUIIAMH, TPOLEAYPAMH,

(pyHKUMAMHU.
Program progl; Program prog3; Unit unitTyp;
{$SAPPTYPE CONSOLE} {$SAPPTYPE CONSOLE} Interface
Uses unitTyp, unitProc, unitFun;
Const Const
nmax=20; nmax=20;
Type Type

ma = array[1..nmax] of shortint;

Procedure psum(const n: byte;
var a: ma;
out S:integer);
Var i: byte;
Begin
S:=0;
For i:=1to ndo S:=S+a[i];
End;

Function fsum(const n: byte;
var a: ma): integer;
Var i: byte; S:integer;
Begin
S:=0;
Fori:=1to ndo S:=S+a[i];
Fsum:=S
End;

Var a: ma; i: byte; sum:integer;

Begin
Write(‘n="); readIn(n);
Writeln(‘A(’,n,”):’);
For i:=1to n do read(a[i]);
Readin;

Writeln(‘procedure psum’);
psum(n, a, sum);
Writeln(‘sum =, sum);

Writeln(‘function fsum’);
Sum:=fsum(n, a);
Writeln(‘sum =, sum);

Write(‘Press Enter’); readln;
End.

{Bce KOHCTaHTbI, THUIIBI,

poLeAyphl U PyHKIIUH
B OTJCNIBbHBIX MOAYJIsAX (Unit)}

Var a: ma; i: byte; sum:integer;

Begin
Write(‘n="); readln(n);
Writeln(‘A(C,n,”):’);
For i:=1to n do read(a[i]);
ReadIn;

Writeln(‘procedure psum’);
psum(n, a, sum);
Writeln(‘sum =, sum);

Writeln(‘function fsum’);
Sum:=fsum(n, a);
Writeln(‘sum =, sum);

Write(‘Press Enter’); readln;
End.

ma = array[1..nmax] of shortint;
Implementation

End.

Unit unitProc;
Interface
Uses unitTyp;

Procedure psum(const n: byte;
var a: ma;
out S:integer);
Implementation

Procedure psum;
Var i: byte;
Begin
S:=0;
For i:=1to ndo S:=S+a[i];
End;

End.

Unit unitFun;
Interface
Uses unitTyp;

Function fsum(const n: byte;
var a: ma): integer;
Implementation

Function fsum;
Var i: byte; S:integer;
Begin
S:=0;
For i:=1to ndo S:=S+a[i];
Fsum:=S
End;

End.
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MeCTOHaXO)KIleHI/Ie HEKOTOPbLIX KOMaH/I
Co3xatb Moayasn (Unit)
File > New = Unit (Delphi for Win32) wmm
File > New = Other = New-Items = Delphi-Projects = Delphi-Files = Unit
J1o0aBuTH yike CylecTBYIOIIU MOAYJIb B IPOEKT:
Project - Add to Project
Yaaauts MOayJ1b U3 NMPOEKTA:
Project > Remove from Project
BeTraBuTh USES B aKTMBHBIN B pelakTOpe KoAa (paidji MOKHO BPYUYHYIO HJIH

U3 CIIUCKA MOJYJIel MpoeKTa:
File = Use Unit...

Komnunsiuus 0e3 3amycka:

Project = Build — mommas, ¢ MepeKOMIMIAIUMCH HMMEIOIIEr0CsS HCXOMAHOTO KoJa
HOKJTFOYCHHBIX MOJTYJICH U

Project > Compile — wacTuuHas, ¢ MEPEKOMIMJISIKUEH TOJBKO HM3MEHEHHBIX (DailyioB
IPOCKTA.

PRJ/ DPR

EXE

A 4

PAS ——| DCU




